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Preface

NOTICE TO CUSTOMERS

of the document.

All documentation becomes dated, and this manual is no exception. Microchip tools and
documentation are constantly evolving to meet customer needs, so some actual dialogs
and/or tool descriptions may differ from those in this document. Please refer to our website
(www.microchip.com) to obtain the latest documentation available.

Documents are identified with a “DS” number. This number is located on the bottom of each
page, in front of the page number. The numbering convention for the DS number is
“DSXXXXXXXXA”, where “XXXXXXXX” is the document number and “A” is the revision level

For the most up-to-date information on development tools, see the MPLAB® IDE online help.
Select the Help menu, and then Topics to open a list of available online help files.

INTRODUCTION

This chapter contains general information that will be useful to know before using the
MCP1663 USB Programmable Power Supply. ltems discussed in this chapter include:

Document Layout

Conventions Used in this Guide
Recommended Reading

The Microchip Web Site
Customer Support

Document Revision History

DOCUMENT LAYOUT
This document describes how to use the MCP1663 USB Programmable Power Supply
Reference Design as a development tool. The manual layout is as follows:

Chapter 1. “Product Overview” — Important information about the MCP1663
USB Programmable Power Supply.

Chapter 2. “Installation and Operation” — Includes description and instructions
on how to use the MCP1663 USB Programmable Power Supply.

Chapter 3. “GUI Installation and Operation” — Includes instructions on how to
install the Graphical User Interface (GUI).

Chapter 4. “GUI Description” — Includes the description for the GUI.
Appendix A. “Schematics and Layouts” — Shows the schematic and layout
diagrams for the MCP1663 USB Programmable Power Supply.

Appendix B. “Bill of Materials (BOM)” — Lists the parts used to build the
MCP1663 USB Programmable Power Supply.

© 2018 Microchip Technology Inc. DS50002722A-page 5
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CONVENTIONS USED IN THIS GUIDE

This manual uses the following documentation conventions:

DOCUMENTATION CONVENTIONS

Description | Represents Examples
Arial font:
Italic characters Referenced books MPLAB® IDE User’s Guide
Emphasized text ...Iis the only compiler...
Initial caps A window the Output window
A dialog the Settings dialog
A menu selection select Enable Programmer
Quotes A field name in a window or | “Save project before build”
dialog
Underlined, italic text with A menu path File>Save
right angle bracket
Bold characters A dialog button Click OK
A tab Click the Power tab
N‘Rnnnn A number in verilog format, 4'b0010, 2'hF1

where N is the total number of
digits, Ris theradixand nis a

digit.
Text in angle brackets < > A key on the keyboard Press <Enter>, <F1>
Courier New font:
Plain Courier New Sample source code #define START
Filenames autoexec.bat
File paths c:\mccl8\h
Keywords _asm, _endasm, static
Command-line options -Opa+, -Opa-
Bit values 0, 1
Constants 0xFF, ‘A’
Italic Courier New A variable argument file.o, where file can be
any valid filename
Square brackets [ ] Optional arguments mccl8 [options] file
[options]
Curly brackets and pipe Choice of mutually exclusive |errorlevel {0]1}
character: { | } arguments; an OR selection
Ellipses... Replaces repeated text var name [,
var name...]
Represents code supplied by [void main (void)
user {

}

DS50002722A-page 6 © 2018 Microchip Technology Inc.
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RECOMMENDED READING

This user’s guide describes how to use the MCP1663 USB Programmable Power
Supply Reference Design. Other useful documents are listed below. The following
Microchip documents are available and recommended as supplemental reference
resources:

* MIC1663 Data Sheet — “High Voltage Integrated Switch PWM Boost
Regulator with UVLO” (DS20005406).

« MCP2221 Data Sheet — “USB 2.0 to >’C/UART Protocol Converter with GPIO”
(DS20005292).

+ USB375x Data Sheet — “USB 2.0 Protection IC with Battery Charger
Detection” (DS00001824).

» MCP454X/456X/464X/466X Data Sheet — “7/8-Bit Single/Dual 12C Digital POT
with Nonvolatile Memory” (DS22107).

» PAC1710/20 Data Sheet — “Single and Dual High-Side Current-Sense Monitor
with Power Calculation” (DS20005386).

THE MICROCHIP WEB SITE

Microchip provides online support via our web site at www.microchip.com. This web
site is used as a means to make files and information easily available to customers.
Accessible by using your favorite Internet browser, the website contains the following
information:

* Product Support — Data sheets and errata, application notes and sample
programs, design resources, user’s guides and hardware support documents,
latest software releases and archived software

* General Technical Support — Frequently Asked Questions (FAQs), technical
support requests, online discussion groups, Microchip consultant program
member listing

» Business of Microchip — Product selector and ordering guides, latest Microchip
press releases, listing of seminars and events, listings of Microchip sales offices,
distributors and factory representatives

CUSTOMER SUPPORT

Users of Microchip products can receive assistance through several channels:

« Distributor or Representative

* Local Sales Office

« Field Application Engineer (FAE)
» Technical Support

Customers should contact their distributor, representative or field application engineer
(FAE) for support. Local sales offices are also available to help customers. A listing of
sales offices and locations is included in the back of this document.

Technical support is available through the web site at:
http://www.microchip.com/support

DOCUMENT REVISION HISTORY
Revision A (March 2018)

« |nitial Release of this Document.
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NOTES:
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Chapter 1. Product Overview

1.1 INTRODUCTION

This chapter provides an overview of the MCP1663 USB Programmable Power Supply
and covers the following topics:

» Core Components Short Overview

» The MCP1663 USB Programmable Power Supply

» What the MCP1663 USB Programmable Power Supply Kit Contains

1.2 CORE COMPONENTS SHORT OVERVIEW
1.2.1 MCP1663 Device Overview

The MCP 1663 is a compact, high-efficiency, fixed-frequency, nonsynchronous step-up
DC/DC converter that integrates a 36V, 400 mQ switch. This easy-to-use product
provides a space-efficient high-voltage step-up, power supply solution. The MCP1663
was developed for applications powered by two-cell or three-cell alkaline, Energizer®
Ultimate Lithium, Ni-Cd, Ni-MH batteries, or Li-lon or Li-Polymer batteries. The
MCP1663 operates in Pulse-Width Modulation (PWM), at a fixed 500 kHz switching
frequency. The device features an undervoltage lockout (UVLO) that prevents fault
operation below 1.85V (UVLOgtop), corresponding to the value of two discharged
batteries. The MCP 1663 starts its normal operation at 2.3V input voltage (UVLOgtaRT)
and the operating input voltage ranges from 2.4V to 5.5V.

For standby applications, MCP1663 can be put in Shutdown by pulling the EN pin to
GND. The device will stop switching and will consume a few pA of input current,
including feedback divider current (250 nA typical). MCP1663 also provides
overvoltage protection (OVP) in the event of the following conditions:

* A short-circuit of the feedback pin to GND

A disconnected feedback divider

In these conditions, the OVP function will stop the internal driver and prevent damage
to the device. This feature is disabled during the start-up sequence and Thermal
Shutdown state.

1.2.1.1  DEVICE FEATURES:

» 36V, 400 mQ Integrated Switch

* Up to 92% Efficiency

» Output Voltage Range: up to 32V

1.8A Peak Input Current Limit:

- lout> 375 MA@ 5.0V V|, 12V Vour
- louT>200 MA @ 3.3V V|, 12V VouT
- lout> 150 MA @ 4.2V V|, 24V VouT
* Input Voltage Range: 2.4V to 5.5V

© 2018 Microchip Technology Inc. DS50002722A-page 9
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» Undervoltage Lockout (UVLO):
- UVLO at V|y Rising: 2.3V, typical
- UVLO at V) Falling: 1.85V, typical
* No Load Input Current: 250 pA, typical
» Sleep mode with 0.3 pA Typical Shutdown Quiescent Current
* PWM Operation with Skip Mode: 500 kHz
+ Feedback Voltage Reference: Vgg = 1.227V
» Cycle-by-Cycle Current Limiting
* Internal Compensation
¢ Inrush Current Limiting and Internal Soft Start
» Output Overvoltage Protection (OVP) in the event of:
- Feedback pin shorted to GND
- Disconnected feedback divider
» Overtemperature Protection
 Easily Configurable for SEPIC, Cuk or Flyback Topologies

1.2.2 MCP2221 Device Overview

The MCP2221 is a USB-to-UART/I2C serial converter that enables USB connectivity
between applications that have a UART and 12C interfaces. The device reduces
external components by integrating the USB termination resistors and the oscillator
needed for USB operation. The MCP2221 also has four GP pins providing
miscellaneous functions (GP1O, USBCFG, SSPND, Clock Output, ADC, DAC, interrupt
detector).

1.2.21 DEVICE FEATURES:

» Supports full-speed USB (12 Mb/s)

* Implements USB protocol composite device

+ 128-byte Buffer to handle data throughput at any UART baud rate

* Human Interface Device (HID) for both 12C communication and control
» 64 byte buffer to handle data throughput at any 12C baud rate

* Fully configurable VID and PID assignments, and string descriptors

* Bus-powered or self-powered

* USB 2.0 Compliant

» USB Driver and Software Support

» CDC and Universal Asynchronous Receiver/Transmitter (UART) Options
« 1C/SMBus

* SMBus Master

1.2.3 USB3751 Device Overview

The USB375x integrates many features that have historically been discrete devices in
a mobile product. This device provides significant VBUS protection for the entire
system, robust USB interface ESD protection, a USB 2.0 compliant High-Speed switch,
and USB-IF Battery Charger detection (revision 1.1) capabilities that are essential to
the latest mobile products. Several advanced features allow the USB375x to be
optimized for portable applications and to reduce both the BOM part count and PCB
area. ESD robustness eliminates the need for external ESD protection devices. In
addition to the integrated ESD protection on the USB interface, the USB375x provides
VBUS Overvoltage Protection (OVP).The USB375x integrated battery charger
detection circuitry supports USB-IF Battery Charger Detection.

DS50002722A-page 10
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Battery charger detection will begin automatically whenever VBUS rises above the
UVLO threshold, and can also be completed manually through the 12C interface. The
USB375x can detect a range of USB battery chargers including a Standard Down-
stream Port (SDP), a Charging Downstream Port (CDP) and a Dedicated Charging
Port (DCP). For more information on USB battery charger detection, please see the
USB Battery Charging Specification, Revision 1.1.

The 12C interface gives processor control over the USB Switch, charger detection,
OVLO settings, and status of the USB375x. In addition, custom charger detection can
be implemented through the 12C interface.

The USB375x family is enabled with SMSC's RapidCharge AnywhereTM, which sup-
ports USB-IF Battery Charging 1.1 for any portable device. RapidCharge Anywhere "™
provides three times the charging current through a USB port over traditional solutions
that translate up to 1.5A via compatible USB host or dedicated charger. In addition, this
provides a complete USB charging ecosystem between device and host ports such as
Dedicated Charging Port (DCP), Charging (CDP) and Standard (SDP) Downstream
Ports.

1.2.3.1  DEVICE FEATURES:

» VBUS Overvoltage Protection
- Protects internal circuits from VBUS up to 9V
- Overvoltage/Undervoltage Lockout opens VBUS switch
- Interrupt to indicate Overvoltage/Undervoltage Lockout
- Integrated Low RpgonFET
+ USB Port ESD Protection (DP/DM/VBUS)
- £15 kV (air discharge)
- +15 kV (contact discharge)
- IEC 61000-4-2 level 4 ESD protection without external devices

» High-Speed USB Mux for multiplexing the USB lanes between different functions
(USB3750 only)

- Switch the USB connector between two different functions
- High bandwidth USB switch passes HS USB signals
» Provides USB Battery Charger Detection for:
- USB-IF Battery Charging compliant Dedicated Charging Ports (DCP)
- USB-IF Battery Charging compliant Charging Downstream Port (CDP)
- Standard Downstream Port (SDP); i.e. USB host or downstream hub port
- Dedicated SE1 type chargers
» Dead Battery Provision Support (USB375x-1 only)

- Allows 100 mA trickle charging from VBUS when attached to a Standard
Downstream Port (SDP) while not enumerated

- Built-in 100 mA current limiting option
* Microchip RapidCharge Anywhere™ Provides:
- Three times the charging current through a USB port over traditional solutions
- USB-IF Battery Charging 1.2 compliance to any portable device
- Charging current up to 1.5A via compatible USB host or dedicated charger

- Dedicated Charging Port (DCP), Charging (CDP) & Standard (SDP) Down-
stream Port support

. flexPWR® Technology
- Extremely low-current design ideal for battery-powered applications
- Maximizes power delivered to the system

© 2018 Microchip Technology Inc. DS50002722A-page 11
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1.2.4 MCP4562 Device Overview

The MCP4562 Digital Rheostats have typical end-to-end resistances of 5 kQ, 10 kQ,
50 kQ and 100 kQ at 8 bits of resolution.

The serial interface options allow you to easily integrate the device into your applica-
tion. The 12C interface allows direct read/write to the wiper register. The 12C interface
supports multiple devices on the serial bus without additional pins. Both volatile and
nonvolatile (EEPROM) memory is available on the same device, allowing the flexibility
to optimize and customize system design.

Low power consumption is an important feature, especially for battery-powered
applications. The maximum supply current is only 5 yA, not including the current for
bus access.

Nonvolatile digital potentiometers allow the desired wiper position to be saved during
device power-down or brown-out condition. When the device power is restored, the
wiper value is loaded from the nonvolatile register, allowing the device to power-on to
the desired wiper settings.This is most useful for both applications where the wiper
value is programmed once and never changed (system calibration) as well as
applications where the last user setting is saved on system power-down (such as
setting a regulator output voltage or a volume setting). Mechanical trim pots have been
used for device calibration to optimize the system performance. A digital potentiometer
with nonvolatile memory can now be a better solution due to its small size and high
reliability.

Microchip’s nonvolatile digital potentiometers adopt a methodology called
WiperLock™ technology, ensuring that once the nonvolatile wiper is “locked,” the wiper
setting cannot be modified except with “high-voltage” commands. This inhibits
accidental modification of the wiper setting during normal operation.

Many of the nonvolatile devices also have some bytes of general purpose EEPROM
memory available. This could be used to store system information, such as calibration
codes, manufacture date, serial number or user information.

1.24.1 DEVICE FEATURES

 Single or Dual Resistor Network Options
» Potentiometer or Rheostat Configuration Options
» Resistor Network Resolution: 8-bit, 256 Resistors (257 Steps)
* Rpp Resistances Options of:
- 5kQ
- 10kQ
- 50 kQ
- 100 kQ
» Zero-Scale to Full-Scale Wiper Operation
» Low Wiper Resistance: 75Q (typical)
* Low Tempco:
- Absolute (Rheostat): 50 ppm typical (0°C to 70°C)
- Ratiometric (Potentiometer): 15 ppm typical
* Nonvolatile Memory
- Automatic Recall of Saved Wiper Setting
- WiperLock™ Technology
- 10 General Purpose Memory Locations
« 12C Serial Interface
- 100 kHz, 400 kHz and 3.4 MHz Support

DS50002722A-page 12
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+ Serial Protocol Allows:
High-Speed Read/Write to Wiper
Read/Write to EEPROM
Write Protect to be Enabled/Disabled
- WiperLock to be Enabled/Disabled
* Resistor Network Terminal Disconnect Feature via the Terminal Control (TCON)
Register
» Write Protect Feature:
- Hardware Write Protect (WP) Control Pin
- Software Write Protect (WP) Configuration Bit
* Brown-out Reset Protection (1.5V typical)
* Serial Interface Inactive Current (2.5 pA typical)
» High-Voltage Tolerant Digital Inputs: Up to 12.5V
» Wide Operating Voltage:
- 2.7V t0 5.5V - Device Characteristics Specified
- 1.8V to 5.5V - Device Operation
» Wide Bandwidth (-3 dB) Operation:
- 2 MHz (typical) for 5.0 kQ Device

1.2.5 PAC1710 Device Overview

The PAC1710/20 are single and dual high-side bidirectional current sensing monitors
with precision voltage measurement capabilities. Each sensor measures the voltage
developed across an external sense resistor to represent the high-side current of a bat-
tery or voltage regulator. The PAC1710/20 also measures the SENSE+ pin voltage and
calculates average power over the integration period. The PAC1710/20 can be pro-
grammed to assert the ALERT pin when high and low limits are exceeded for Current
Sense and Bus Voltage. The PAC1710/20 device is good for measuring dynamic
power. The long integration time allows for extending system polling cycles without los-
ing any power consumption information. In addition, the alert ensures that transient
events are captured between the polling cycles.

1.2.5.1 DEVICE FEATURES:

+ Single and Dual High-Side Current Sensor

- Current measurement is integrated over 2.5 ms to 2.6s with up to 11-bit
resolution

- 1% current measurement accuracy in positive range
- Measures Vgoyrce Voltages
+ Calculates Power
* Vsource Voltage Range 0V to 40V
+ Bidirectional Current Sensing
» Auto-Zero Input Offset Voltage
+ Digital Averaging
- Adjustable sampling time and resolution
* 5 uA Typical Standby Current
» Programmable Sense Voltage Range
- 10 mV, £20 mV, +40 mV, and £80 mV
» Power Supply Range 3.0V to 5.5V

» ALERT Output for Voltage and Current out of Limit Transients Between Sampling
Interval

© 2018 Microchip Technology Inc. DS50002722A-page 13
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* SMBus 2.0 Communications Interface
- Block Read and Block Write
- Address selectable by resistor decode
» Sample Time Configurable from 2.5 ms to 320 ms
- With averaging effective sampling times up t0 2.6 s

1.3 THE MCP1663 USB PROGRAMMABLE POWER SUPPLY

The MCP1663 USB Programmable Power Supply is used to demonstrate interfunc-
tionality between a broad range of analog and digital Microchip devices, by means
of a real life application: a complete and programmable power supply.

The compact packaging and high integration of the Microchip ICs fitted on the board
allows the entire solution to be very small, the size of common USB FLASH Stick.

Voltage regulation is performed by the MCP 1663 in SEPIC configuration. This topology
allows the user to both step up and step down the 5V USB input voltage to a regulated
output between 2.5V and 30V.

The coupled SEPIC inductor solution requires a smaller PCB area and reduces radi-
ated electromagnetic interference (EMI). Another advantage of using a coupled induc-
tor is the fact that only half of the calculated inductance is needed. A capacitor
connected between the first inductor and the second inductor offers DC isolation and
protection against a shorted load. The capacitor clamps the winding leakage induc-
tance energy and eliminates the need for a snubber circuit. The input inductor smooths
the current draw and reduces the required input filtering.

Setting the regulated output voltage is done by the MCP4562 Digital Rheostat, which
is programmed via 12C to adjust the feedback voltage divider ratio.

On the output side, the PAC1710 senses the output voltage level and load current, then
reports the values via 12C access.

The MCP2221 acts as I°C master to the above and USB bridge. This allows the user
to freely program the output voltage and read back the load current. Since the output
voltage is also measured, the application automatically fine tunes the output to match
the voltage to the desired selection.

In order to negotiate maximum current from the PC USB charging port and also to
provide surge protection, the USB3751 is managing the Power Supply’s interface to
USB.

The application described is not limited to PC USB input. Once the nonvolatile memory
of the MCP4562 is programmed with the desired output voltage, the Power Supply can
be connected to any USB power source (i.e., wall plug, USB car charger, etc.)

1.4 WHAT THE MCP1663 USB PROGRAMMABLE POWER SUPPLY KIT
CONTAINS
The MCP1663 USB Programmable Power Supply kit includes:

* MCP1663 USB Programmable Power Supply (ARD00698)
 Important Information Sheet
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Chapter 2. Installation and Operation

21 INTRODUCTION

The MCP1663 USB Programmable Power Supply provides a versatile and easy-to-use
power supply solution for engineers. Whether supplied from a USB port of the com-
puter or a wall plug, it delivers a wide range output voltage, from 2.5V to 30V.

Thanks to the on-board High-Speed USB switch, the MCP1663 USB Programmable
Power Supply can draw up to 1.5A from the USB host/wall plug.

An application with a simple GUI allows for quick voltage setting, as well as power
measurement.

Before using the power supply with a wall plug, the user must first program the output
voltage through the application. An EEPROM stores the value, until reprogrammed to
a different one.

The reduced dimensions (the size of a USB flash stick) is key for portability.

| *
--.p|USB Switch|g - - - - USB-to-I°C ¢ - ~- - | DIGIPOT
. USB3751 MCP2221 ' MCP4562 SEPIC
: ;V Isolated Buck-Boost
. DC-DC
; MCP1663
PC USB . -p|!/V Sensor
Charger PAC1710
r— — — " r - - "
co | 12.5V-30V |
ok Ul | LOAD |
L — — L — —
FIGURE 2-1: MCP1663 USB Programmable Power Supply Functional Blocks.

22 MCP1663 USB PROGRAMMABLE POWER SUPPLY FEATURES

2.21 Board Features

» 2.5V to 30V programmable output voltage (0.5V increments)
» Up to 1.5A peak input current

» Automatic disconnect in case of short circuit

» Nonvolatile memory for output voltage storing

» Output power measurement (voltage/current)

© 2018 Microchip Technology Inc. DS50002722A-page 15
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222 Application Features

« 2.5V to 30V programmable output voltage (by track bar and numeric input)
* Overload indication

Instant output power indication

Multiple device support with individual programming

Self calibration for precise voltage output

* Emergency STOP button

2.3 GETTING STARTED

Plug the MCP 1663 USB Programmable Power Supply into any USB port of the PC and
wait for the drivers to install. The “Your device is ready to use” pop-up message dis-
plays, signaling the device drivers are installed and the GUI is safe for launch.

Once powered, the MCP1663 USB Programmable Power Supply will source the last
stored output voltage (regardless of the application being started or not). If there is no
LED activity and the output voltage read is 0V, the device is disabled by software. Refer
to Chapter 4. “GUI Description” for operation instructions.

To set the output voltage to a new desired level or to monitor output voltage and current,
the MCP1663 USB Programmable Power Supply must be plugged into a USB port or
preferably into a USB charging port, for maximum current capabilities.

2.4 OPERATION

After installing the application, run the “USB_Programmable_PS.exe.” The GUI will
launch to an idle operation (see Chapter 4. “GUI Description”). The MCP1663 USB
Programmable Power Supply overview is depicted in Figure 2-2.

The board is supplied from the USB type A, while the regulated output voltage is acces-
sible on the output terminal block.

A green LED indicates the Output Status. It switches ON, when the user activates the
MCP1663 SEPIC regulator. If the regulator is disabled from the GUI (see Chapter

4. “GUI Description”), the output voltage drops to 0V and the green LED switches
OFF.

A red LED indicates whether an over-current situation has occurred (ALERT). It
switches ON when a current surge is detected on the MCP1663 USB Programmable
Power Supply input. The ALERT remains active until a power cycle is performed.

usB

TYPEA OUTPUT
i STATUS

+
OUTPUT

ALERT

FIGURE 2-2: The MCP1663 USB Programmable Power Supply Overview.
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Chapter 3. GUI Installation and Operation

3.1 GETTING STARTED

In order to install, use and evaluate the product, there are several software and
hardware tools required to be installed and/or configured.

311 Required Software

* USB Programmable Power Supply GUI (minimum v.1.0.0)
« Microsoft®. NET Framework 4.5 or Higher
+ Microsoft® Windows® 7

3.1.2 Required Hardware
* MCP1663 USB Programmable Power Supply

3.2 GRAPHICAL USER INTERFACE INSTALLATION

The following steps describe how to install the USB Programmable Power Supply GUI:

1. If Microsoft .NET Framework is already installed, go to Step 2. If not, download
Microsoft .NET Framework from www.microsoft.com and follow the installation
instructions.

2. Download the USB Programmable Power Supply GUI (v.1.0.0) archive from
www.microchip.com/DevelopmentTools/ProductDetails.aspx?PartNO=ARD00698,.

3. Unzip the USB Programmable Power Supply GUI archive, which contains the
UsbProgrammablePowerSupply-vl.0.0-windows-installer.exe file.

4. Double click on the file to open the InstallShield Wizard window and wait for the
extraction to complete. If required, the installation can be stopped by clicking the
Cancel button.

© 2018 Microchip Technology Inc. DS50002722A-page 17
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5. In the Welcome to the InstallShield Wizard, click the Next button to start the
installation.

—‘._‘: USB Programmable Power Supply v1.0.0 Setup - |EI|£|

Application Install

Welcome to the Setup Wizard for the USE Programmable Power Supply.

5]

0
T
U
0
T
—
=
4

< Badk Next = , ........ C ancel‘l

FIGURE 3-1:  Starting the MCP1663 USB Programmable Power Supply GUI
Installation.

6. Read the License Agreement. Select the “| accept the agreement” option in order
to proceed. Click on the Next button to continue.

-.S UsB Programmable Power Supply v1.0.0 Setup - | Ellil

License Agreement @

Pleasze read the following License Agreement. You must accept the terms of this agreement before
continuing with the installation.

MICROCHIP IS WILLING TO LICENSE THE ACCOMPRANYING SOFTWARE AND o
DOCUMENTATION TO YOU ONLY ON THE CONDITION THAT YOU ACCEPT ALL OF

THE FOLLOWING TERMS. TO ACCEPT THE TERMS OF THIS LICENSE, CLICK
"1 ACCEPT™ AND PFROCEED WITH THE DOWNLOAD OR INSTALL. IF ¥0U DO
NOT ACCEPT THESE LICENSE TERMS, CLICE "I DO NOT ACCEPT,™ AND DO
NOT DOWNLORD OR INSTALL THIS SOFTWRRE.

MICROCHIP NON-EXCLUSIVE SOFIWARE LICENSE AGEEEMENT
FOR USE Programmable Power Supply LI

™ I accept the agreement
Do you accept this license?
I do not accept the agreement

< Back Mext = Cancel

FIGURE 3-2: The MCP1663 USB Programmable Power Supply GUI
Installation.
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7. The installation path can be changed, although it is recommended to keep the
default path. Click on the Next button to continue.

-£. UsSB Programmable Power Supply v1.0.0 Setup - | Ellil

Installation Directory @

Pleaze specify the directory where the USE Programmable Power Supply will be installed.

Installation Directory I :\Program Files (x86) WicrochipUsbProgrammabl IE

< Back Mext = Cancel

FIGURE 3-3: Selecting the Destination Folder.

8. In the Ready to Install window, click on the Next button and wait for the
application to proceed with the installation. The progress can be observed in the
“Status” bar.

-;S UsB Programmable Power Supply v1.0.0 Setup - | Ellil

Ready to Install Q

Setup is now ready to beqin installing the USE Programmable Power Supply on your computer.

< Back , ....... Next:b._l cancel

FIGURE 3-4: Installing the MCP1663 USB Programmable Power Supply GUI.
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9. Once the installation completes, select the View Release Notes File check box
to view release notes and revision history, or deselect this check box to skip.
Click the Finish button to complete the installation.

To start the GUI, either click on the desktop icon or navigate to Windows Start>All
Programs>Microchip>USB Programmable Power Supply>USB Programmable

Power Supply.

1._‘-: USB Programmable Power Supply v1.0.0 Setup o [m] |

Install Complete

The USE Programmable Power Supply has been successfully installed on your
computer.

¥ view Release Notes File

o

0
T
U
0
Ty
—
2
4

= Badk i Finish Cancel

FIGURE 3-5: The Installation Complete Window.

3.3 MCP1663 USB PROGRAMMABLE POWER SUPPLY GUI UNINSTALL

In order to install a new version of the MCP1663 USB Programmable Power Supply
GUI, any previous or corrupted versions should be removed from the computer.

To uninstall, go to Windows Start>All Programs>Microchip>USB Programmable Power

Supply>Uninstall USB Programmable Power Supply. Click the Yes button to remove
the application from the PC.

x

I-'/ -\'-I Do you want to uninstall USE Programmable Power Supply and all
k. ¢ 4 of its modules?

FIGURE 3-6: Uninstall the MCP1663 USB Programmable Power Supply GUI.
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When the uninstallation is complete, a pop-up displays confirming the successful unin-
stallation. Click the OK button to exit.

ioixd

Uninstalling USB Programmable Power Supply @

Uninstall Status

SETE— x

:l Uninstallation completed

x|

< Back Mext = Cancel

FIGURE 3-7: GUI Uninstall Complete.
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Chapter 4. GUI Description

41 INTRODUCTION

After installing the application, run the USB_Programmable PS.exe file. The GUI will
launch to an idle operation. If the MCP1663 is connected to one of the USB ports, then
the GUI displays “Device Connected.” Otherwise, it displays “Device Disconnected.”

4.2 THE GRAPHICAL USER INTERFACE

-l

Space reserved for

/real time graphs

Data acquisition
Reset / Stop

-

HESEFl STOF'l Output Voltage
/ Selection

[ v Set Output |

—1

25V 30V

\ | Device Connected |

FIGURE 4-1: Power-up View of the GUI.

After checking that the MCP1663 USB Programmable Power Supply is attached, set
the output voltage to the desired level, between 2.5V and 30V. This can be done by
numeric input or simply sliding the track bar.

Clicking the Set Output button triggers the regulator into operation (if idle) or readjusts
the output according to the selected voltage. During operation, the voltage and current
graphs generate in real time, along with the output power calculation. On the board, the
Green LED turns ON to show that the output is powered.

© 2017 Microchip Technology Inc. DS50002722A-page 23
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Click the STOP button to disable the voltage regulator and discharge the output to OV.
Data acquisition for real time graphs can be halted by clicking the STOP button again,
while the output voltage discharge is below 0.1V. The output can be activated again by
clicking the Set Output button. Data acquisition for real time graphs also resumes.

An important feature of the application is that it automatically fine tunes the output
voltage to match the desired voltage setting. This is possible by sensing the voltage
close to the output of the MCP1663 USB Programmable Power Supply and
incrementing the voltage level in steps, until minimum deviation from target voltage is
reached.

The RESET button allows the user to remove all previous acquired data for the graphs.
This does not affect the voltage regulation, fine tuning of output setting.

Sl

Output Voltage (Vis)
20

Output voltage
10 : - graph in real time

0 2 4

Load Current Consumption (més)

2

15

1 ' Current consumption
- - . .
| graph in real time

0.5

0

0 2 4

Instant output instart Power:  RESET | [ sT0P | Instant power
voltage =~ ———» | 1653vxfise mal-[003 wl ~&——Consumption

Set Qutput |

Instant current J \
consumption 2 Activate the programmed

output voltage

OUtpUt voltage Device Connected
selection

FIGURE 4-2: MCP1663 USB Programmable Power Supply GUI Operation.
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Appendix A. Schematics and Layouts

A1 INTRODUCTION

This appendix contains the following schematics and layouts for the MCP1663:
* Board — Schematic

* Board — Top Silk

» Board — Top Copper and Silk

* Board — Top Copper

» Board — Bottom Copper

» Board — Bottom Copper and Silk

* Board — Bottom Silk

© 2018 Microchip Technology Inc. DS50002722A-page 25
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Schematics and Layouts
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A.5 BOARD - TOP COPPER

A.6 BOARD -BOTTOM COPPER

04-10468-R1
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Appendix B. Bill of Materials (BOM)

TABLE B-1: BILL OF MATERIALS (BOM)
Qty. | Reference Description Manufacturer Part Number
3 C1, C2, Capacitor ceramic, 0.1 pF, 16V, 10%, X7R, | Wurth Electronik 885012206046
C6 SMD, 0603
1 C3 Capacitor ceramic, 10 pyF, 16V, 10%, X5R, | Wurth Electronik 885012107014
SMD, 0805
1 C4 Capacitor ceramic, 10 uF, 10V, 10%, X5R, |Taiyo Yuden Co., Ltd. LMK212BJ106KG-T
SMD, 0805
1 C5 Capacitor ceramic, 10 pF, 50V, 20%, X7S, | TDK Corporation C3225X7S1H106M
SMD, 1210
1 Cc7 Capacitor ceramic, 1 uF, 50V, 20%, Y5V, Samsung, Inc. CL21F105ZBFNNNE
SMD, 0805
1 C8 Capacitor ceramic, 1 uF, 16V, 10%, X5R, AVX Corporation 0603YD105KAT2A
SMD, 0603
1 C9 Capacitor ceramic, 0.1 pF, 50V, 10%, X7R, | Cal-Chip Electronics GMC21X7R104K50NTLF
SMD, 0805 Inc.
1 D1 Diode SCTKY DB2X41400L, 490 mV, 2A, Panasonic® - ECG DB2X41400L
40V, SMD, SOD-123F
1 J1 Connector USB2.0, STD-A, Male, TH, R/A | Molex® 0480370001
1 J2 Connector TERMINAL, 5 mm 1x2, Female, |PHOENIX CONTACT |1935161
12-26AWG, 18A, TH, R/A
1 L1 Inductor, 10 uH, 1.1A, 20%, SMD, Wurth Electronik 744877100
L7.3W7.3H4
1 LABELA1 Label, AIPD Board Assembly
1 LD1 Diode LED, Green, 2V, 30 mA, 35mcd, Lite-On®, Inc. LTST-C191KGKT
Clear, SMD, 0603
1 LD2 Diode LED, Red, 2V, 30 mA, 2mcd, Clear, Lite-On®, Inc. LTST-C190EKT
SMD, 0603
4 PAD1, Mechanical HW rubber pad, cylindrical, 3M SJ61A11
PAD2, D7.9, H5.3, Black
PAD3,
PAD4
1 PCB Printed Circuit Board — MCP1663 USB Pro- | Microchip Technology 04-10468-R1
grammable Power Supply Reference Design Inc.®
1 Q1 TRANS FET, P-CH, BSS84, -50V, -130 mA, |Diodes Incorporated® BSS84-7-F
300 mW, SOT-23-3
1 Q2 TRANS FET, N-CH, NDS7002A, 60V, Fairchild Semiconduc- | NDS7002A
280 mA, 2R, 0.3W, SOT-23-3 tor®
2 R1, R7 Resistor, TKF, 1.3k, 5%, 1/10W, SMD, 0603 | Panasonic® - ECG ERJ-3GEYJ132V
4 R2, R3, Resistor, TKF, 10k, 1%, 1/16W, SMD, 0603 | TE Connectivity, Ltd. 5-1879337-9
R6, R10
2 R4, R5 Resistor, TKF, 8.2k, 1%, 1/10W, SMD, 0603 | Panasonic® - ECG ERJ-3EKF8201V
Note: The components listed in this Bill of Materials are representative of the PCB assembly. The

released BOM used in manufacturing uses all RoHS-compliant components.
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TABLE B-1: BILL OF MATERIALS (BOM) (CONTINUED)
Qty. | Reference Description Manufacturer Part Number
1 R8 Resistor, TKF, 300k, 1%, 1/10W, SMD, 0603 | Panasonic® - ECG ERJ-3EKF3003V
1 R9 Resistor, TKF, 2k, 1%, 1/10W, SMD, 0603 Panasonic® - ECG ERJ-3EKF2001V
1 RB Resistor, TKF, 3.3k, 1%, 1/10W, SMD, 0603 Panasonic® - ECG ERJ-3EKF3301V
1 REN Resistor, TKF, 1M, 1%, 1/10W, SMD, 0603 | Panasonic® - ECG ERJ-3EKF1004V
1 RS Resistor, TKF, 0.025R, 1%, 1/2W, SMD, Panasonic® - ECG ERJ-6BWFR025V
0805
RT1 Resistor, TKF, 330k, 1%, 1/10W, SMD, 0603 | Panasonic® - ECG ERJ-3EKF3303V
1 RT2 Resistor, TKF, 59k, 1%, 1/10W, SMD, 0603 | Panasonic® - ECG ERJ-3EKF5902V
1 U1 Microchip Interface USB 12C/UART Microchip Technology MCP2221A-I/ML
MCP2221A-I/ML QFN-16 Inc.®
1 u2 Microchip Analog Digipot 1-Ch 50k Microchip Technology | MCP4562-503E/MS
MCP4562-503E/MS MSOP-8 Inc.®
1 u3 Microchip Analog Switcher Boost 32V Microchip Technology MCP1663T-E/OT
MCP1663T-E/OT SOT-23-5 Inc.®
1 u4 Microchip Analog Current Sense Monitor Microchip Technology PAC1710-1-AlA-TR
PAC1710-1-AlA-TR DFN-10 Inc.®
1 us Microchip USB2.0 Protection IC with Battery | Microchip Technology USB3751A-2-A4-TR-ND
Charger Detection USB3751A-2-A4-TR Inc.®
QFN-16
Note: The components listed in this Bill of Materials are representative of the PCB assembly. The

released BOM used in manufacturing uses all RoHS-compliant components.
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